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Description of the BBHW system

Accessing BBHW
BBHW is a Web-based application that you access via URL. There are two (2) versions of the
system: Test and Production (LIVE). When entering the Test and Production (LIVE) Systems,
use your State ID or Utah ID (also referred to as “UMD”) to log in.

1. For UDOH employees, this is your network login username and password
2. For LHD employees, this is the same username and password used to login/connect to

the AppStream for the UCCP Tracker.

Test Version of BBHW System
This version of the system is for testing and training purposes only. The data included in
this system is not valid.

For testing and training go to: https://bbhw.at.utah.gov/bbhw

PLEASE NOTE: If you enter client information in the test system it should be for testing
and training purposes only and should not be real data. Under no circumstances should
real client information be entered into Test BBHW.

Production (LIVE) BBHW system
This version of the system is where you will enter client information.

The URL is https://bbhw.health.utah.gov/bbhw
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Descriptions of the Navigation Bar Options

New Enrollment: Leads you to the New Enrollment section where you begin a patient search to
add a new enrollment to an existing patient or add a new patient and enrollment.

Patient Search: This provides fields for searching for patient/client records in the database.

BeWise: This is a shortcut to BeWise health coaching group sessions.

Documents: This section will be used to upload templates for relevant documents. Currently
there are English and Spanish consent forms and the BBHW User’s manual under this section.

Admin: This provides shortcuts and tools for BBHW system administrators.

Settings: This includes information about the user. Please keep your settings information
current!

1. View only: Username is displayed, but cannot be edited
2. Edit and View: Name, Job title, Phone, Email, Address, City.

View options:
Patient View - After clicking on a Patient record the user will see the
basic Patient information towards the top of the screen. Above this, in
the top left part of the Patient screen is a “View” menu. To open the
menu, move the mouse cursor over the View. A menu opens with the
following: Demographic, Contact Details, Consent Form, Enrollments,
and B&C Clinical. The user can either navigate to these tabs in the
Patient screen by using the menu from the View or by clicking on each
tab individually.

The “View” menu also allows the user to switch to an “accordion” view.
The Show Accordion option is the last option listed. This changes the
Patient screen from the default with Tabs to an “accordion” view.
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Expand and close the different sections in the according view by clicking the arrow to the left of
the section name.

All of the sections can be opened or closed all at once, by clicking either the “Open All” or
“Close All” in the View drop-down menu.

If you want to return to the Tab view, click on the Show Tabs option, listed
as the last option in the View drop-down.

Enrollment View -  After clicking on an Enrollment record the user will see
the basic Patient information towards the top of the screen. Above this, in
the top left part of the Enrollment screen is a “View” menu. To open the
menu, move the mouse cursor over the View. A menu opens with the
following: Overview, Demographic, Contact, Intake Interview, BeWise
Intake Measurements, Referrals, and B&C Results.. The user can either
navigate to these tabs in the Patient screen by using the menu from the
View or by clicking on each tab individually.

The “View” menu also allows the user to switch to an “accordion” view.
The Show Accordion option is the last option listed. This changes the
Patient screen from the default with Tabs to an “accordion” view.
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Expand and close the different sections in the according view by clicking the arrow to the left of
the section name.

All of the sections can be opened or closed all at once, by clicking either the “Open All” or
“Close All” in the View drop-down menu.

If you want to return to the Tab view, click on the Show Tabs option, listed as the last option in
the View drop-down.

Navigate option

In the upper left portion of the Enrollment screen or
the BeWise screen, next to the View navigation
menu, is the Navigate option. This can be used to
Navigate from the Enrollment screen to either the
Patient screen or the BeWise screen. If in the
BeWise screen, use the Navigate option to navigate
to the Patient screen or to the Enrollment screen.
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Patient Search

Search Criteria Section:
In BBHW when you navigate to patient search, there are a number of search fields that can be
used to do the Patient search. They are: Patient’s full name, Birth date, Last name, First name,
Middle name, Enrollment Id, Patient Id, or Referral number can be searched under the “Search
Criteria” section.

Advanced Search Section:
Users can search for patients under the tabs of the Advanced Search section. These tabs
contain searchable fields by Contact info and Health Coach.

1. Contact Info: Search for patients using their address, zip code, county, phone or email.
2. Health Coach: Search for patients by the name of the health coach.

Search Results
After entering in your search criteria, a list of results will appear when you click “search”. A list of
results will be given by patient ID, Name, Birthdate (age), Address, and Last Enrollment Date.
To enter a patient’s record, click on their patient ID in the column to the right of the “score”.
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”Score” indicates the how closely the result matches what you entered in the search

The system will allow you to search using nicknames.
For example: If I search “Kate” the search results will include people names “Kathy”
“Kate” “Katie” and other names that commonly use Kate as a nickname.
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Patient Records
After you have searched for a patient and clicked on their Patient ID in the search results, you
will be taken to the main screen of a patient record. On this screen, there are a number of tabs;
Demographic, Contact Details, Consent Forms, Enrollments, and B&C Clinical.

Demographic
Under this tab, you can see the patient’s demographic information, such as name, birthdate,
age, gender, is deceased, their race, language, and ethnicity, and literacy information, annual
income, and insurance coverage.

Contact Detail
Under this tab, you can see information on
whether the patient requested no further contact,
is hearing impaired, if it is ok to text, and the
patient’s address, phone number and email.

With address, phone number, and email a
Patient can have more than one added to the
system. With each (address, phone number, and
email there are additional options to select one
as preferred or as incorrect. If selected as
preferred, it will appear at the top of the screen
with other Patient information and be included on
“print outs” and other items created by the
BBHW application that include Patient
information.
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Consent Forms
Under this tab, you can view the code for the consent, generate a code, text or email
instructions and manually upload consent forms. You will also be able to view when the last
consent form was signed.

Enrollments
Under the enrollments tab, you can see a list of the patient’s enrollments. You will find the
enrollment ID, clinic date, recorded date, enrollment status, clinic name, and services enrolled.
Under the “Action(s)” column you can click “Options” and navigate to several places in the
BBHW system for that enrollment. You may edit the enrollment you are currently on, view the
enrollment, go to BeWise, flag for deletion or delete the enrollment.

B&C Clinical
Under this tab, you will see who the patient’s Primary Care Provider is, and the information from
the most recent enrollment or from the eligibility check. You do not need to update information
here.

Creating a New Patient and Enrollment Or Adding a
New Enrollment to Existing Patient

NEW ENROLLMENT search
Use the NEW ENROLLMENT search as a first step to begin a new enrollment. At a minimum
search using the Patient’s Last Name and First Name (Note: it is a best practice to use the
patient’s full last name and the full first name when searching. Do not worry if the name is not
spelled correctly. BBHW’s search will find similar name matches if the name spelling is close).
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Any search results that have a matching score of at least 30% will be displayed, showing the
following for the Patient record: ID, match Score, Name (last, first, middle), Date of Birth,
Eligibility status, and status of Last Enrollment. Returned results can be expanded to view
additional details, such as additional patient identity details and all the enrollments for the
patient.

On the right side of each returned search result are “Edit Patient” and “+ Add Enrollment”
buttons. Use the “Edit Patient” button to edit any of the patient information. To add a new
enrollment to the patient record, use the “+Add Enrollment button”.

Clicking on the Options button next to each Enrollment shows the following:
● Edit Enrollment - use this to open the Enrollment in Edit mode to make any changes to

the Enrollment. If the user opens an Enrollment in Edit mode, this creates a “data lock”
on the Patient and Enrollment record for this user. Meaning that another user that opens
this same patient or enrollment record at the same time, will not be able to edit any of the
data. The second user will be shown a message that the patient/enrollment record is
locked and which system user has the data lock.

● View Enrollment - use this to open the enrollment in View mode. This will allow the user
to view enrollment information without adding the “data lock” to the patient and
enrollment record.

● BeWise (if enrollment has BeWise services); Or BeWise - Not Enrolled (if enrollment
does not include BeWise services)

● Flag for Deletion - use this if the enrollment needs to be deleted. If an enrollment is
flagged for deletion, the user will need to notify either the B&C Program or BeWise
Program at the State that the enrollment has been flagged for deletion so it can be
deleted.
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Add Patient
If there are no matching patient results, use the “+Add Patient” button to create a new patient
record. Any of the information entered to do the New Enrollment search is carried over from the
search to the patient record to be added/created.

Note: the “+ Add Patient” button is disabled if the New Enrollment search does not include both
Last Name and First Name.

Add Patient Screen

The add patient screen has a Create Patient button and a Create Patient & Enroll button.
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● Create Patient - creates a patient record with an enrollment. The enrollment can be
added to the patient record later when desired.

● Create Patient & Enroll creates a patient record and takes the user through eligibility
steps to create an enrollment.

Eligibility Process
Anytime a new enrollment is created, BBHW will take the system user through the eligibility
steps. These steps are: Basic Questions, Advanced Questions, Eligibility Determination, and
BeWise QI (Quality Improvement). Automation has been programmed into the eligibility process
to determine whether or not the Patient is eligible for program services based on the responses
entered at each step. Below are descriptions for each step.

● Basic Questions covers the following for the Patient being enrolled.
○ Birthdate
○ Annual Income
○ # in Household
○ Does Patient Have Medicare Part B?
○ Does the Patient have Other Medicare? (if response is “Yes”, a follow up field

requesting Medicare # appears)
○ Is the patient pregnant or breastfeeding?
○ Clinic (drop-down menu)
○ Primary Care Provider (drop-down menu)

● Advanced Questions. The Advanced Questions step only applies to Patients between
the ages of 21-39 years. If the patient is 40 or older, this step is skipped.

○ Have you (the Patient) had a Pap smear before?
■ If a Pap smear is documented in the Patient’s previous enrollment from

the Intake Interview, this question is auto-populated with the information
from the previous enrollment. If this information is not correct, the system
user can update this information.

■ Note: If it has been at least 10 years since the Patient has had a pap
smear, the Patient will be eligible for cervical services.

○ Did breast symptoms lead to this visit?
■ If the response is “yes” the Patient will be eligible for breast services.
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● Eligibility Determination shows the services for which the Patient is eligible. Select the
services the Patient is enrolling for in the enrollment (Breast Services, Cervical Services,
BeWise Services).

○ Note: an INFO note appears in this section identifying the services (B&C and/or
BeWise) the Patient for or not eligible for (if not eligible).

● BeWise QI. This step will only happen if the Patient is eligible for BeWise services and
was not enrolled in BeWise services. This is a “quality improvement” check to ensure
that all BeWise eligible Patients are at least offered BeWise services.

Click the Finish button to complete the eligibility determination and create the new enrollment.

Electronic Consent Form Process

General Information:
The electronic consent form process currently brings together the UCCP Tracker application
and the new BBHW web-based application to:

1. Create/generate an electronic copy of the UCCP & BeWise Consent and Authorization
Form;

2. Send (via email or text) an electronic copy of the UCCP & BeWise Consent and
Authorization Form to the B&C/BW client for electronic signature;

3. Allow the client to electronically sign the consent form and submit it to the B&C and BW
programs through an automated process; and

4. Automatically populate the “Consent Form Received On:” field in the UCCP Tracker and
provide an electronic copy of the signed consent form in the BBHW system.

Electronic Consent Signing Process steps:
1. New patient enrollment created/entered and saved in the UCCP Tracker
2. Open BBHW system, click on PATIENT SEARCH, search for patient

3. Open correct Patient (Patient ID)
4. Go to the “Consent Forms” tab
5. In the Consent Forms tab, the user can…
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a. See if an electronically signed consent form exists
b. Open Consent Signing Page
c. View Code (this is a consent form verification code that is needed for the client to

access and electronically sign their consent form)
d. Generate Code (this generates a new consent form verification code, for when a

client does not electronically sign their consent for in a timely manner. The
verification code expires after two weeks [14 days]).

e. Send Instructions. Email contains a link to the Consent Form Signing Page.

6. If the client/patient is physically present when the enrollment is created and can
electronically sign it at the moment. Staff can use the Open Consent Signing Page
button to access the Consent Form page to allow the client to provide the necessary
credentials (Date of Birth, Security Code) to Verify. Then access, electronically sign, and
submit the electronic consent form. A Spanish version of this page is available by
clicking the link on the right side of the page.

7. If the client/patient is not physically present when the enrollment is created, they must
have an email address or cell phone recorded in their UCCP Patient Record to proceed
with the electronic consent form process. With an email address/cell phone in the Patient
Record, a link to the Electronic Consent Form page will be emailed and/or texted to the
client. Note that for the time being, any email addresses or phone numbers entered into
BBHW during the consent signing process, will not be saved onto that client’s record. In
order for email or phone numbers to be saved to the client record, you must enter that
information into the UCCP Tracker.

a. Note: in the BBHW test, all generated emails with the
Consent Form page are programmed to be sent to
the email account you have listed as a user in
“settings”.

b. Your user information can
be updated by clicking on
“settings” at the top right of
the navigation bar
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8. Consent Form Signing Page
a. Enter client date of birth
b. Enter the security code (this is the consent form security code available when

clicking the “View Code” button in the Consent Forms tab.
c. If the client speaks Spanish, click on “Traducir al Español” in the top left of this

window to generate a Spanish consent form.

9. If the Client has an electronic consent that has been signed and is valid based on
expiration dates, an error message stating “Error! Consent Form already submitted” will
be displayed.

10. If no valid consent form is previously submitted, the electronic consent form in the
requested language will be generated for the client. The client then has two options to
sign the electronic consent form. They can either type their name in as it appears at the
top of the consent form, or if using a touch screen or computer with a mouse, they can
electronically sign the consent with their signature.

a. Once signed, the client will click the submit button
to complete the process.

b. Using the Topaz Signature Pad:
■ Step 1 - click "Activate Topaz"
■ Step 2 - use Topaz signature pad to enter

signature
■ Step 3 - click "Done"
■ Step 4 click "Submit Consent" to submit

electronic signature

To install the software, users may need tech support from Local DTS

PLEASE NOTE:  To use the Topaz signature pad with BBHW the Topaz hardware needs the SigWeb software. See
below for installation steps:

1. Go to <https://www.topazsystems.com/sdks/sigweb.html> and either download the latest SigWeb software or
follow the steps provided to sign up for the SigWeb Certificate Updater.

2. Before installing the downloaded SigWeb software, be sure to close all open browsers (i.e. Chrome, Firefox,
Internet Explorer, etc).

3. Run/install the downloaded SigWeb software and please use "T-LBK755-BHSB-R" for the signature pad
model, unless the user is using a different mode. Note: IT support may be needed to run/install the SigWeb
software.

11. An electronically signed consent form can be viewed in the BBHW system by clicking on
the patient, and opening the Consent Forms tab.
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a. Consent Form tab shows the following:
■ Signed On date
■ Signed Language (English or Spanish)
■ Form Status (Note: this is the status of the version of the consent form

that was signed, and not the status of the signed consent form.)
■ Action(s) allows you to view a PDF version of the electronically signed

consent form.
■ Note: A signed consent form where the Form Status is “Valid”, will remain

valid for a period of 4 years and 9 months. However, if the Form Status is
Not Valid, a new signed consent form will be required for new
enrollments, even if the new enrollment falls within the 4 year and 9
month time period.

12. In the UCCP Tracker, once an electronically signed consent form has been submitted,
the “Consent From Received On:” date field will be populated with the date
(MM/DD/YYYY) the electronically signed consent form is submitted.

a. Note: this process does not add an attachment of the signed consent form in the
UCCP Tracker. A PDF version of the signed consent form is available in the
BBHW system. Users no longer need to attach a PDF in the Tracker or send a
copy to the state office once they begin using the BBHW system.

Adding Manual Consent Form to BBHW Process
Instructions for adding a manual Consent Form to BBHW.

The following are the steps for completing the manual consent form and adding it to BBHW.

Step 1 --- Click on the “DOCUMENTS” link in the purple banner ribbon at the top of the BBHW
screen

Step 2 --- Click on the Active Consent Form link (English or Spanish version) to open the
version of the consent form.
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This will load an electronic version of the Consent Form for download using the “Print” button.
Note: at the bottom left of the consent form, the Form Version [Name] and [Date]
(MM/DD/YYYY) are highlighted in yellow (see image on next page of these instructions). The
BBHW user needs to add the consent form version [Name and Date] when attaching the
manual consent form to BBHW (see Step 7 in these instructions).

Step 3 ---  Click the Print button, located at the top left corner of the consent form page to print a
copy of the consent form. If the patient is present, print the consent form and give the hard copy
(paper copy) of the consent form to the patient to read, sign, and date. If the patient is not
present, you can use the Print button to create a pdf version of the consent form that can be
emailed or faxed to the patient. To create the pdf version, click the Print button and in the Print
dialogue box, in the Destination field, select the “Adobe PDF” option and at the bottom of the
dialogue box click the blue print button

Step 4 --- Instruct the patient to add their Date of Birth and add their Name at the top of the
consent form in the  Date of Birth: and Name: spaces provided.

Step 5 --- Once the patient has completed the consent form by writing in their Date of Birth &
Name [at the top] and signing & dating [at the bottom] of the hard copy (paper copy) of the
consent form, upload the signed copy to BBHW. See Step 6.
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Step 6 --- In BBHW, find the patient record using the PATIENT SEARCH link. Open the patient
record and open the Consent Forms tab. Click on the “+Attach New Consent Form” button.

Step 7 --- In the Consent Form Upload (Manual Upload) dialogue box, in the Consent Form
Version field put in the consent form Name and Version as it appears on the original consent
form (this is highlighted in yellow at the bottom of the consent form, labeled as “From Version”).

Complete the Signed On Date field. This needs to be the date the consent form is signed by
the patient.
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Step 8 --- Click the + Consent Form Uploader button. Navigate to where the signed consent
form is saved and select the saved consent form.

Step 9 ---  Click the upload the selected file button.
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Step 10 --- Verification step. This step is to allow the user to verify that they grabbed the correct
signed consent form for the patient record.

Step 11 --- The consent form should now be saved to the patient record in BBHW. Verify this by
closing the Consent Form Upload (Manual Upload) dialogue box. This will return you to the View
Patient page in BBHW where you should now see the consent form added to the patient record.
You will know the consent form is added by the following indicators: the Signed On date field will
have the date the consent form was signed;  under the Signed Language field is displayed
“Manually Signed”; under the Form Status field, you’ll see “Active and Valid”; and under Actions
you’ll see the “Download PDF” button enabled.

Step 12 --- In the UCCP Tracker, in the Overview tab of the Enrollment the Consent Form
Received On: date has the date the manual consent was uploaded to BBHW.

20



Version 1.3

Note: if the manual consent form is uploaded to the patient record in BBHW before the
Enrollment is created. When creating the Enrollment in the UCCP Tracker, the Consent Form
Received On: date field will be populated with the date the consent form was uploaded to
BBHW.

Adding a Short-Term Follow-up to a B&C Enrollment

What is a Short-Term Follow-up
According to CDC definitions for the Breast and Cervical Cancer Screening Program the
Short-Term Follow-up is defined as a case in which the provider decides that immediate
diagnostic work-up is not needed, and there is a planned delay for diagnostic work-up between
the current and the subsequent visit for the Patient. The Short-Term Follow-up begins a new
special type of enrollment that is linked to the “parent” enrollment. In normal situations, a Patient
with an abnormal result would be scheduled for immediate diagnostic follow-up which is
reported in the enrollment with the screening test that indicated the need for immediate
diagnostic evaluation. Short-Term Follow-up is defined by the provider’s intent. It is not the
amount of time that passes between tests which is relevant, but rather the reason the time
passed. Therefore if there is a delay in diagnostic work-up due to other circumstances (e.g.
where the Patient delays it on their own) this does not meet the requirements for a Short-Term
Follow-up..

Creating a Short-Term Follow-up Enrollment
The option to add a Short-Term Follow-up is shown at the top right of the Enrollment screen.
You cannot add a Short-Term Follow-up unless the Enrollment is open in Edit mode. Also, the
Add Short-Term Follow-up is disabled for 90 days (three months) from the Clinic Date
(enrollment date) of the Enrollment. Also, the Add Short-Term Follow-up is disabled 1 year from
the Clinic Date (enrollment date).  Only one Short-Term Follow-up for each Breast and Cervical
can be added per Enrollment.

A Short-Term Enrollment is identified from other enrollments in the  Enrollment tab by looking in
the Status next to the status in parentheses as “(short-term follow-up for [enrollment id inserted
here])”.
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Navigating BeWise

Enrolling a Participant in BeWise
1. Follow the enrollment process described above in the section titled “Creating a New

Patient And Enrollment Or Adding a New Enrollment to an Existing Patient”
2. If a client is determined eligible for and accepts BeWise services after initial enrollment

you will need to edit the enrollment and click on BeWise for the required fields to display
and will have to refresh the participants record,

3. In the enrollment process you will complete all the initial assessment questions if the
client has been offered, is eligible, and accepted BeWise Services.  The BW required
questions are in the tabs

a. BW - Health History
b. BW - Health Behaviors
c. BW - Food Security
d. BW - Stage of Change

4. You can navigate to the BeWise sections in different ways. The intent of creating multiple
paths is to support the different workflows that each location uses to implement the
program.

a. From the Enrollment screen (described above), you can access functionality to:
■ Establish eligibility for BeWise
■ Complete the intake and assessment questions
■ Enter screening measurements
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■ Send, issue and document BeWise Clinical and health behavior support
services referrals.

■ Link into the Health Coaching module - to link to HC from this screen click
on Left navigation titled “Navigation” and choose “BeWise”

b. From the Patient screen (described below), you can access functionality to:
■ Enter screening measurements
■ Send, issue and document BeWise Clinical and health behavior support

services referrals.
■ Document sessions Health Coaching

Open BeWise from Patient screen
WIth the Patient open, go to the Enrollments tab.

Click on the Options menu. The following options will be available: Edit Enrollment, View
Enrollment, BeWise (if enrolled in BeWise services) or BeWise - Not Enrolled (if not enrolled in
BeWise services), and Flag for Deletion.

To go to the BeWise services screen, click on the BeWise option.

This opens the page up in BeWise. The BeWise Screen has the following tabs: Measurements,
Diagnosis, Referrals, Health Coaching, Notes.
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Click “Add Measurements” on the right side of the screen.

Enter clinical measurements as required by the BeWise Program:
1. Height can be searched in INCHES

2. Weight can be searched in POUNDS

3. Hip and Waist Measurements can be searched in INCHES

4. If systolic blood pressure is ≥140 OR diastolic blood pressure is ≥90 AOBP must be
performed.

24



Version 1.3

a. If AOBP is not performed, the reason must be selected from the drop
down box, and a note must be written in the “AOBP Comment” field.

You will enter the date of these measurements, the client’s fasting status, and that Risk
Reduction Counseling was performed after you have entered the clinical data.

Press SAVE, and then EXIT. If you press EXIT before SAVE you will lose your work.

Diagnosis Tab

If the client has any previous diagnosis in the system, they are displayed in this tab. .

Referrals Tab
The Referrals Tab has the following sections:

● Current Referrals - listing of client referrals for the current enrollment
● Previous Referrals - listing of client referrals from other enrollments for the client
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● Eligible Referrals - list of referrals the client is eligible for based on clients intake1

interview questions or measurement values

Note: In order to see the most recent list of referrals that the client is eligible for, you
may need to refresh your screen by clicking the refresh button on your internet
browser.

Health Coaching Tab
The Health Coaching Tab is covered in detail in the Health Behavior Support Services section.

BeWise Notes Tab
The Notes Tab contains the following sections:

● BeWise Notes - these notes are notes that are entered using the + Add Note  button
found in this BeWise Notes Tab. They can be general notes that the Health Coach,
nurse, or other user has regarding the client. The newest or most recent note is
displayed at the top of the list.

To add a BeWise Note, click the “+Add Note” button. Select the “Note type” from the
drop-down. Add the note in the free text note field. Then hit the “Save” button to save the
note.

For each BeWise Note that is saved, the system shows the user that created the note,
the type of note, and the date and time the note was created.

Filtering BeWise Notes --- In the BeWise Notes section, there is a filter that allows the
user to select one of three filter options. (1) All notes. (2) Health Behavior Support
Services notes. (3) BeWise Clinical Screenings notes.

1 Please note:  If a client is eligible for a specific referral the referral must be offered.  If the client declines
to  participate please annotate in the appropriate referral.

26



Version 1.3

● Health Coaching Session Notes - these notes are displayed in the Notes tab but are not
created here. The Health Coaching Session Notes are entered into the individual health
coaching sessions and displayed here with the newest or most recent note at the top of
the list.

For each Health Coaching Session Note, the note includes the Session Id # as well as
the Session Date.

There is no way to edit or delete a BeWise note once it has been entered and saved. However,
there is an option to “Strikethrough” the note. This is considered a “soft delete” of the note. The
Strikethrough option is turned on by clicking in the box next to the Strikethrough option. To
remove the Strikethrough, just click the box, which will have a check mark in it. This returns the
note to its original state without the strikethrough.
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Health Behavior Support Services

Navigating to Health Coaching
1. Enter the name of client/participant in the search (see description above)
2. Select the client you wish to view health coaching/BeWise services
3. Click the “Enrollment” Tab
4. Choose the appropriate enrollment

5. Click the “options” drop down to the left of the enrollment and select “BeWise”

6. Once you select “BeWise” you will see tabs across the top labeled - to access all HBSS
click on the “Health Coaching” tab

a. Measurements (see description below)
b. Diagnosis (see description below)
c. Referrals (see description below)
d. Health Coaching: Documentation for Health Coaching and other Health

Behavior Support Services (HBSS) are located in this Tab (see description
below)

e. Notes (see description below)
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Adding Health Coaching Session

1. Once you are in the health coaching tab, you select the “Add Health Coaching
Session” button located on the top right side of the screen.

2. Then you will select the type of health coaching session that you would like to
complete.

3. The new session you created will appear at the top of the list with the session
date listed as the day you created it.

4. In order to edit the session, you will need to click on the “Options” button on the
right side of the screen and select “ Edit Session.”

What happens if I create a session that needs to be deleted “Flagging Session
for Deletion”

● In the BBHW system, you may flag certain data elements for deletion. When an
item is flagged for deletion, the following indicator appears:

● To flag for deletion simply click the “options” drop down and then select “Flag for
deletion”

● Items that are flagged for deletion are reviewed by a system admin, and they can
delete the items at their level. System admins may contact you with questions
about items flagged for deletion.

29



Version 1.3

Edit a session
In order to make any changes to a session, you will need to push the “Options” button in
the line of the session you would like to change, and then select “Edit Session.”

You are able to edit any session listed in the client’s history. So if a mistake has been
made or you forgot to document some information in the session, select “Edit Session”
on the session you would like to change and make the necessary edits.

Basic Information
The first tab that will appear when entering a coaching session will be called “Basic Info.”
Here you will document the type of coaching encounter (face to face, phone, etc.), the
duration of the session, and the name of the health coach. The new additions to this
page include a list of medications, a list of diagnoses, and a free text box to type any
notes on diagnoses.
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Reported Medication(s)
Any medications that the client reported in their interview will be shown here. You are
welcome to add any additional medication that the client is currently taking that is
applicable.

Diagnosis History
The diagnosis history will pull any diagnoses that the client has reported along with any
diagnoses found by the Breast and Cervical Program as a part of the client’s program
participation.

1. Keep in mind, these diagnosis entries may take some time to be entered, so they
won’t appear right away.

2. Also, you should NEVER share this information with the client. If a client has
been diagnosed with a condition, they need to be informed by a medical provider
to receive proper education on their condition.

3. This information has become available to you so that you are aware if a client
has received any diagnosis that would change how you would coach them and
prepare you before you call the client.

4. ALWAYS wait for the client to tell you their diagnosis before making any comment
towards it. If you feel there are additional diagnoses that should be included,
make sure to include them in the notes section.

Goals2

There are two sections under the goal tab, the Previous Session Goals and the Current
Session Goals.

2 Please Note: The system allows only 3 goals to be assigned to a client at a time.
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Goal Review (see screenshots below):
If you would like to view the goals that the client set during their last session within this
enrollment (If it’s their first session, there won’t be any goals listed here), you will need to
expand the Previous Session Goals by clicking the expand button. There you will see
the goal set, as well as the confidence and the success levels of the client.

To review the goals in order to continue or discontinue them:
1. Click the “Review Goals” button on the right side of the screen.
2. Document/record a success level for the goal and select a goal status.
3. Click “Save” to include your changes on the client’s session record.

Other Recent Goals:
This section details the most recent goals the client has set from their previous
enrollment.
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Incentives, Tip sheets and Notes
Support Tools: to document the support tool(s) that were provided to the client simply

1. Select the drop down menu.
2. Scroll through the list to the appropriate selection or you can shortcut by typing

the name of the tool you are looking for in the text box. The list will generate the
tool options that most closely match your search.

3. Click the box next to the appropriate tool(s) to indicate which tools were  provided
to the client.

33



Version 1.3

4. Tipsheets: Choose the topic of the tipsheet(s) that were provided to the client, by
clicking on the box next to the corresponding topic.

a. For example, if the client received a tipsheet related to nutrition, you will
indicate that a nutrition tipsheet was provide

5. Life Circumstance Notes: This new addition to the health coaching screen will
allow for documentation of special circumstances related to the client’s Mental
Health, Living Challenges, Crisis Situations, and Food Insecurity issues. If the
client is experiencing or dealing with anything in these categories, please indicate
them in the corresponding field. If none of these apply to the client, please leave
the fields blank.

6. Session Notes: This box is for the health coach to include any additional
information about the session that they feel is applicable. Helpful things to include
would be anything related to the client’s vision, strengths, barriers, and
motivations.

Final Health Coaching Session
CDC requires that every client come back in 5-7 months after their initial visit to do an in person
health coaching session so that clinical values can be collected. All best efforts need to be made
to get the client to come back in. However, we understand that some clients will be unable to
come back. In these instances, you will complete the final session in the place of a 5-7 month
follow up. In the health coaching screen, you will select the Final Session to complete
documentation:
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You will document all of the tabs within the session (same as all other coaching sessions), but
you will also need to answer the Assessment Questions.

Referrals
You can issue and send all the HBSS referrals in this section.  Creating a referral is simple

1. Click “Create Referral” and select the type of referral you wish to create
2. Once created go into the “options” drop down and select edit to finalize and send the

referral to contracting agencies.  Referrals issued from health coaching include: EFNEP,
Weight Watchers, SMBP, MTM, and the Quitline.

The system will generate a list of referrals that the client is eligible for based on their answers to
the interview questions, their clinical values, and eligibility criteria for each referral type. The
client is not required to complete all of the referrals, but it is the job of the health coach to help
the client understand the value of the referrals and refer to as many as the client will accept
participation in.

Please Note: If the client is eligible for a referral please offer and document refusal if the client
opts to not participate.
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All referrals are set up essentially the same. You will fill in the information on the “Referral
Information” tab, and double check the client’s contact information on the “Client Information”
tab. Additional steps for each referral are detailed below.

EFNEP (Expanded Food and Nutrition Education Program)

There are no additional steps for this referral. Simply fill in the information on the
“Referral Information” tab and double check the contact information on the “Client
Information” Tab and send a copy of the referral to EFNEP. See Printing and Sending
Referral.

Weight Watchers

■ Follow the instructions for all referrals and fill in the referral information
and double check the client information tab.
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■ Under the “Referral Services” tab, you will indicate which Weight Watcher
location the client will attend.

■ Then you will submit the referral to Weight Watchers and provide them
with any necessary support tools (food scale, measuring cups, measuring
spoons). When the client arrives at Weight Watchers, they will be
provided a points calculator and a manual free of charge.

■ See Printing and Sending Referral that describes how to send the referral
to Weight Watchers and the client.

Weight Watchers Additional Session and Follow up

■ When you are completing follow up coaching sessions with the client, you
will collect the dates of attendance to their classes and the weights
collected at each session. In order to record these, you will select “create
Session” and record necessary information. The client will have a book
given to them by Weight Watchers where they will have all of this
information recorded.

■ Once the client has attended at least 10/12 sessions, they will be eligible
for an additional 12 sessions. You access the same referral and will again
return to the same “Referral Services” tab. There you will click the
“Eligible for Additional Sessions” button and resubmit the referral to
Weight Watchers allowing the client to attend another 12 sessions (total of
24 sessions per enrollment). See: Printing and Sending Referral

■ PLEASE NOTE: If you have a client who is having success with Weight
Watchers and wishes additional sessions beyond the standard 24
sessions, or had extenuating circumstances that prevented them from
attending the initial 10/12 sessions but would like to continue attending,
please contact Stephanie Wilkinson for approval to extend Weight
Watcher referral.

5-7 Month In-Person Follow-up Health Coaching Session
○ The 5-7 month follow up session will only appear as an option in Health

Coaching when specific criteria are met in the system.
■ Must be more than 5 months after first session
■ The system will allow you to document a 5-7 month follow up with

1 health coaching session documented in the current enrollment.
However, 5-7 month policy requires that the client complete at
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least 3 health coaching sessions before their 5-7 month in-person
session.

○ Clinical measurements are collected during the 5-7 Month In-Person
Health Coaching session.

○ If the client does not come in person and get measurements taken
then you will complete the final assessment instead of the 5-7 Month
In-Person Health Coaching Session.

○ In the health coaching navigation screen, you will select the 5-7 Month
Session to begin documenting session

1. You will fill out all of the tabs that appear within the session.
2. Please follow instructions detailed in the Measurements Section for entering

clinical values.
3. Evaluate Goals, document any additional support tools, tip sheets, or referrals

administered.
4. Document Risk Reduction Counseling.
5. Reassess and document the self-reported health history questions
6. CDC considers health coaching complete at 3 sessions and requires that we

complete a final assessment 4-6 weeks after completion of HBSS - this can be in
the form of a final assessment plus the measurement (known in Utah is the “5-7
Month In-Person Follow-up Health Coaching Session”) or a final assessment
which is done over the phone.

PLEASE NOTE: When a 5-7 Month Health Coaching Session is complete, the
measurements collected will show up in the Measurements Tab outside of Health
Coaching as view only.  Measurements collected/entered in a 5-7 month health coaching
session can only be edited in the health coaching session.

Self-Monitored Blood Pressure (SMBP)
1. To create a referral to SMBP, select “Create

Referrals” as indicated above.
2. Select “SMBP” from the drop down menu.
3. Enter the required information in the “Referral

Information” tab.
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4. And click the “Save New Referral” button in the right upper corner.

5. You will be directed to a page that looks like this:

6. Select “Referral Services” and then click “Create Session” on the right side of the
screen. You will be directed to a page that looks like this:

7. Enter the date, service type (face-to-face, phone), duration, discussion topics
and most recent blood pressure. Please note, fields will be added to facilitate the
entry of two blood pressures in the future.

8. Lastly, select either “Save & Continue” to enter additional SMBP sessions, or
“Save & Exit” to exit.

Medication Therapy Management (MTM)
■ Coming Soon! More information will follow!

Tobacco Quitline

There are no additional steps for this referral.
1. Simply fill in the information on the “Referral Information” tab and double check

the contact information on the “Client Information” Tab.
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2. The one unique aspect of this referral is that you have to document the patient’s
agreement to provide their quitting results to the UCCP (Similar to documentation
required in UCCP Tracker Referral).

3. Send referral to the Quitline (see Printing and Sending Referral)

Documenting Group Sessions
1. Go to the top right navigation and

select “BeWise” inside the purple
ribbon.

2. Choose the drop down “Health Coaching Groups”
3. Once the screen below is visible you have 2 options

a. Edit the existing classes  - Select “edit button” to the right of any of the previously
entered classes.

b. Enter a new class- Select “Add Group Session”

4. Once you add a group session you complete the form
below that describes the class.

5. Name the class, fill in the topic, health coaching,
duration of the class and any information that is helpful
in the “notes.”

6. Make sure to hit the “save” button on the top right.
7. After hitting the save button you will go to the next

screen where you enter the names of the individuals
attending the session.
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Adding participants to the Group Session
1. Type in the person's name, email, or phone.
2. Press 'Enter' key and wait for the results list to generate.
3. Select the person from the results list.
4. Repeat steps 1 to 3, if additional participants need to be

added.. Ignore this step, otherwise.
5. To remove people from the selected list, click the 'x' button

next to their name. Ignore this step, otherwise.
6. Finally, to associate the selected people with this group

session, click the 'Save' button from the top-right corner of
this page.

7. Once saved, the class information is added  to each participant's enrollment and you will
be able to see it in the “Health Coaching” Tab.

Group Session Screen Functionality
1. You can navigate to their individual health coaching session by clicking on “Health

Coaching.”
2. Change the “Session Type” from  Face-to-face, phone or teleconference.
3. Change from “Group Session” to “Combined Session” (Combined Session: Participant

attended both an Individual and Group Session on same day).
4. See which enrollment the Group Session is associated with.
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5. At any time, you can add additional people if you forgot to include someone in the class.

User Note to the Health Coaches for Group Sessions
1. Based on the BeWise program's needs, this search interface only returns people who

have at least completed their initial health coaching session.
2. The newly created group/combined session will be associated with that person's most

recent enrollment with a history of health coaching.
3. The system will allow more than one person in this section at a time but any changes

made will not be saved. Recommendation: Assign one person to manage the class list.
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Printing and Sending Referral
Each referral has the functionality to send the information via email or fax.

1. Click on “options” for the referral you wish to send.
2. From this drop down box you can select

“download printout” to print or “send
printout” via email, fax or both
depending on if you click “provider” or
“client”

3. Once you choose “Send Printout” the
popup will appear. Note that the system
will default to sending the printout to the
client.

4. Click who you are sending the
information to “client” or “provider” and
the system will display sending options.

5. Enter the recipient's information and hit “Send” to send the printout.

PLEASE NOTE: When you send the referral to the Tobacco Quitline or Weight Watchers, the
system will auto populate each of these agencies information and will send referral to the
number on file when you click the “send” button.

For all other providers, referrals, or client emails or faxes please verify and document the correct
information.
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Scheduling
The system allows the user to schedule an appointment (such as a
Health Coaching session) or create a task and set up reminders for
the client as well as for the health coach.

In the top left of each screen in the BeWise section of BBHW there is
a button titled “Schedule Next Visit. Follow the steps listed below to
schedule an appointment, create a task, and/or set up reminders.

1. Click on “Schedule Next Visit”
a. This opens a calendar that shows schedule

appointments and/or tasks for the client as well as the system user
2. Schedule calendar has a month, week, or day view. Click on the “month” or “week” or

“day” option to the top right of the calendar to select the view you want to see.
3. Once in the view, the user can use the left or right arrows to the top left of the calendar to

move forward or backwards, either by month, week, or day depending on the current
view of the calendar.

4. The different events scheduled on the calendar are designated by a different color.
a. Red are appointment schedule for the client
b. Yellow are appointments for the user that is signed into the BBHW application.
c. Green are tasks for the user that is signed into the BBHW application.

5. To schedule a new appointment, create a task, or set up a
reminder, click on the  “Add Event/Task” button which is
located on the top left of the calendar pop up.

6. A “Meeting Details” pop-up dialogue box appears with the
following fields:

a. Purpose of Next Visit/Reminder field. This is a single select drop-down menu.
Select the option the indicates the purpose of the next visit/reminder.

b. Event Details field. This is a free text field that can be used to document
additional details. It is up to the discretion of the user what to add here. However,
the information added here is intended to provide the client with the information
that may be helpful such as:

i. Address of the appointment
ii. Instructions the client needs
iii. What does the client do if they need to reschedule

c. Meeting Host field. This is the contact person for the client to reach out to for the
appointment or if they have questions for the “visit/reminder”

d. From field. Date and time the event is scheduled to start.
e. To field. Date and time the event is scheduled to end.
f. Send Reminders to Host check box. Select the check box if the user would like to

enable the option to send the Host reminders.
g. Send Reminders to Client check box. Select the check bos if the user would like

to enable the option to send the Client reminders.
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h. Send Host Reminders To selections. Select the options for the Host to receive
the reminders.

i. Send Client Reminders To selections. Select the options for the Client to receive
the reminders.

j. Send Client Reminders On selections. Select options for when to send the Client
reminders.

k. Client Language Preference. Select with English or Spanish. The reminder for
the Client will be sent in either English or Spanish depending on what is selected.

l. Additional Comments. Additional comments are intended for the BBHW user and
are not sent in the reminder.

PLEASE NOTE: Each referral will allow you to edit the client’s contact information before
sending them the referral. Please verify contact information before sending.

The system will use the information in “settings” to send the
“host’s” reminder.

Practice Scenarios
Searching for a client and Enrolling them into the programs.

Search for yourself in the UCCP tracker test system and if you haven’t done one before please
create a participant record with your name or another unique name not currently in the system.
After you create a unique record enter the required intake information for an enrollment on the
New Patient, Overview, and Interview sections.

When completing the assessment questions please
1. Check “yes” to the smoking question and “yes” to the question that a Quiltine referral is

wanted.
2. Make the record as unhealthy as you can, for example, they have hypertension and

diabetes but are not taking medication, etc.

After you have entered your information in the UCCP tracker, move over into BBHW and search
for your record. You can use any search field to find  the record you created. Once you have
searched for the record you wish to enter, click on the patient ID field to open that record. For a
refresher on searching in BBHW click here.

Using the the record you created above:
Enter clinical values:
Enter the following clinical information:
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● Height: 5’ 2”
● Weight: 185 lb
● Waist: 42 in
● Hip: 42 in
● BP #1: 162/99
● AOBP: 148/93
● CHOL: 255
● TRIG: 300
● HDL: 35
● LDL: 105
● A1c: 7.8

Enter the current date as the date of service and mark the client as fasting with risk reduction
counseling completed.

Create a client printout and send it via email to atesta@utah.gov.

Entering Tobacco Quitline Referral
The tobacco quitline referral has been moved into BBHW. Using the record that you previously
created enter and complete a  tobacco quitline referral.  For more information on how to create
a Quitline Referral click here .

Clinical Referral
Clinical referrals are not automatically created based on screening values, therefore, you must
create them manually.  The client you entered is eligible for a referral based on their screening
values. Create a clinical referral for the client to follow-up at Mountainlands-Provo for an
appointment in 7 days.

Send a provider print out via email to atesta@utah.gov

Entering SMBP
The client is eligible for an SMBP referral. Create the referral and enter a session, including
type, duration, topics and at least one blood pressure.

Send a provider printout via email to atesta@utah.gov

The client then refuses to continue SMBP. Change their referral status to “Patient Refused.”

Entering Weight Watchers
Create a Weight Watchers referral for the client. Fax the referral to (801) 237-0772.

Entering EFNEP
The individual decides to be referred to EFNEP.  Document an EFNEP referral and send to
yourself.  Please note things in the test system will automatically send to the user that is
initiating the referral so you should get an email notification about the referral (if you send it)
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Entering Tobacco Quitline
The client agreed to participate in and so you created a quitline referral.  Once you have created
the referral you notice that you are in the wrong client and need to delete the referral. Flag the
referral for deletion.

Entering health coaching sessions
1. Enter a health coaching session on the participant that you created dated between 5-7

months ago with all the information about the session, the materials you gave the client,
and what goals were set.

2. Enter a second session dated 2 months after the initial session.
3. Enter the final session or the 5-7 month session.

Scheduling (assign yourself a task or send a patient/client reminder)
1. Use the “Schedule Next Visi” button (top right of screen) to schedule and send a

reminder to the Patient/Client and the Health Coach

Sending Referrals
1. In the Referrals tab of BeWise, find a Referral and click the Options and select the “Send

Printout” option.
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